LIST OF CONTENTS

1. BASIC OPERATIONS AND MAIN MENU ........................................... 1
   1.1 ADAPT-ABI MAIN SCREEN ................................................................. 3
   1.2 MOUSE FUNCTION AND OPERATION ............................................... 4
   1.3 CURSOR FUNCTION AND OPERATION ............................................. 5
   1.4 OPERATION OF RETURN AND TAB KEYS ....................................... 6
   1.5 OPERATION OF KEY COMBINATIONS ............................................ 6
   1.6 HOW TO END/CLOSE AN OPERATION ........................................... 6
   1.7 HOW TO ABANDON AN OPERATION ............................................... 6
   1.8 MAIN MENU ..................................................................................... 7
      1.8.1 File Menu ..................................................................................... 7
      1.8.2 Edit Menu ................................................................................... 8
      1.8.3 View Menu .................................................................................. 8
      1.8.4 User Interface Menu ................................................................. 9
      1.8.5 Settings Menu ............................................................................ 10
      1.8.6 Tools Menu ................................................................................ 12
      1.8.7 Modify Menu ............................................................................. 13
      1.8.8 Material Menu .......................................................................... 16
      1.8.9 Moving Load Menu ................................................................. 20
      1.8.10 Model Menu ............................................................................ 22
      1.8.11 Build Menu ............................................................................. 23
      1.8.12 Loading .................................................................................... 23
      1.8.13 Process ..................................................................................... 27
      1.8.14 Report ....................................................................................... 28

2. TOOLBARS AND DIALOG WINDOWS .............................................. 31
   2.1 MAIN TOOLBAR ............................................................................... 33
   2.2 SETTINGS TOOLBAR ......................................................................... 34
   2.3 SELECTION TOOLBAR ....................................................................... 34
   2.4 CAMERA AND VIEWPORTS TOOLBAR ........................................ 39
   2.5 SELECTIVE VIEW TOOLBAR ........................................................... 40
   2.6 SNAP TOOLBAR ............................................................................... 41
   2.7 DRAW TOOLBAR AND DRAW MINI TOOLBAR .............................. 43
   2.8 GRIDLINE TOOLBAR ....................................................................... 47
   2.9 COPY / MOVE TOOLBAR ................................................................. 48
   2.10 SCALING TOOLBAR ....................................................................... 49
   2.11 UCS TOOLBAR ............................................................................... 50
   2.12 VIEWPORT TOOLBAR ..................................................................... 50
   2.13 TRANSFORM TO STRUCTURAL COMPONENTS TOOLBAR .......... 51
   2.14 MODEL TOOLBAR .......................................................................... 52
   2.15 POINT SUPPORT TOOLBAR ............................................................ 62
   2.16 BUILD/ASSEMBLE STRUCTURE TOOLBAR ............................... 63
   2.17 TRAVELER TOOLBAR ..................................................................... 65
   2.18 OFFSET AND RESTRAINT TOOLBAR ............................................ 65
2.19 LOAD REPORT TOOLBAR ................................................................. 66
2.20 LOAD TOOLBAR ............................................................................ 66
2.21 REFERENCE LINE TOOLBAR ......................................................... 69
2.22 SPAN/COLUMN TOOLBAR ............................................................... 70
2.23 SPRING TOOLBAR ......................................................................... 70
2.26 CELL TOOLBAR .............................................................................. 71
2.27 TENDON/STAY TOOLBAR ............................................................... 71
2.28 MODIFY SELECTION TOOLBAR ..................................................... 72
2.29 STRUCTURAL COMPONENTS/AIDS DISPLAY TOOLBAR ............... 72

3. ADAPT-ABI VIEWER MENU ITEMS AND TOOLBARS ............... 75

3.1 ADAPT-ABI VIEWER MAIN SCREEN ................................................. 77
3.2 ADAPT-ABI VIEWER MENU ITEMS .................................................. 78
  3.2.1 File Menu .................................................................................... 78
  3.2.2 Edit Menu .................................................................................... 79
  3.2.3 View Menu ................................................................................... 80
  3.2.3 User Interface Menu ................................................................. 80
  3.2.4 Settings Menu .............................................................................. 81
  3.2.5 Results Menu ............................................................................... 81
  3.2.6 Tools Menu .................................................................................. 83
  3.2.7 Moving Load Menu ................................................................. 84
3.3 ADAPT-ABI VIEWER TOOLBARS .................................................... 85
  3.3.1 Display Stages Toolbar ............................................................... 85
  3.3.2 Action and Stresses Toolbar ....................................................... 85
  3.3.3 Displacement Toolbar ............................................................... 86
  3.3.4 Settings for Results Toolbar ..................................................... 86
  3.3.5 Display Combinations ............................................................. 87
  3.3.6 Selection Toolbar ................................................................. 88
  3.3.7 Main Toolbar .............................................................................. 88
  3.3.8 Scale Toolbar ............................................................................. 89
  3.3.9 Views Toolbar ............................................................................ 89
  3.3.10 Display Components/Entities Toolbar ..................................... 91
  3.3.11 Moving Load Toolbar ............................................................. 94
# Chapter 1

## BASIC OPERATIONS AND MAIN MENU

1.1 ADAPT-ABI MAIN SCREEN ................................................................. 3
1.2 MOUSE FUNCTION AND OPERATION .............................................. 4
1.3 CURSOR FUNCTION AND OPERATION .............................................. 5
1.4 OPERATION OF RETURN AND TAB KEYS ....................................... 6
1.5 OPERATION OF KEY COMBINATIONS .............................................. 6
1.6 HOW TO END/CLOSE AN OPERATION ............................................ 6
1.7 HOW TO ABANDON AN OPERATION .............................................. 6
1.8 MAIN MENU ....................................................................................... 7
   1.8.1 File Menu ................................................................................. 7
   1.8.2 Edit Menu ............................................................................... 8
   1.8.3 View Menu ............................................................................. 8
   1.8.4 User Interface Menu ................................................................. 9
   1.8.5 Settings Menu ....................................................................... 10
   1.8.6 Tools Menu ........................................................................... 12
   1.8.7 Modify Menu ......................................................................... 13
   1.8.8 Material Menu ....................................................................... 16
   1.8.9 Moving Load Menu ................................................................. 20
   1.8.10 Model Menu ......................................................................... 22
   1.8.11 Build Menu .......................................................................... 23
   1.8.12 Loading .................................................................................. 23
   1.8.13 Process .................................................................................. 27
   1.8.14 Report ................................................................................... 28
This Page Left Intentionally

BLANK
1.1 ADAPT-ABI MAIN SCREEN

Fig. 1.1-1 shows the full-screen display of the ADAPT-ABI program, with typical features labeled for easy identification. ADAPT-ABI operates the same way as other Windows programs. All program tools are accessed from one of the toolbars provided by the program or through the menus provided in the menu bar at the top of the screen. Toolbars may be opened, closed, “docked” to the edge of the screen or dragged to any position on the screen as View menu item, or by clicking the right mouse button while the cursor is in the Menu Bar or Toolbar areas of the screen.

**FIGURE 1.1-1 ADAPT ABI MAIN SCREEN**

**Menu Bar.** Lists all available menus in the main program window. Menu options will be grayed out when they are not applicable.

**Toolbars.** Contains all available tools in the main program window. The tools will not be available if they are not applicable.
Project Browser. Enables you to define project timeline. If you right click on a day, you can add a step for that specific day or delete the day. If you right click on a step you can either delete or rename a step. To add a day, enter the day number in the field on the bottom of the Project Browser and click on the Add button. To view calculation results for each step, check the Output All checkmark on the bottom of the Project Browser.

Command Line. Displays tool-specific information prompted to the user and any coordinate values that may be typed by the user for specific program procedures.

Status Bar. Displays such information as the mouse cursor coordinates, current unit system, snapping status, and gridline spacing and status. A short description of each specific tool also appears in this area when the mouse cursor is placed over the corresponding tool button.

1.2 MOUSE FUNCTION AND OPERATION

The primary function of the mouse is through its left-click. Depending on the mode of the program, as outlined in the next section, the left-click will result in selecting the entity below the cursor, inserting an entity or performing an operation at the location of the cursor.

The right-click of the mouse with cursor on the display portion of the screen will display the window shown in Fig. 1.2-1.

Click on a menu item listed to perform the operation described.

If you right-click the mouse while the cursor is outside the display screen, a list of all available toolbars appears. From this list, you can select the toolbars you want to display.
1.3 CURSOR FUNCTION AND OPERATION

Depending on the cursor mode, the program responds differently. Before starting an operation, it is important to make sure that the cursor is in the appropriate mode.

<table>
<thead>
<tr>
<th>Shape</th>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Selection/Pick" /></td>
<td>Selection/Pick</td>
<td>In this mode, you can select an entity displayed on the screen by placing the cross over it and left-clicking the mouse. Once an entity is selected, its color changes. There are two ways to enable Selection/Pick mode: • Right-click the mouse, and select Exit • Click on Selection/Pick Tool</td>
</tr>
<tr>
<td><img src="image" alt="Hint" /></td>
<td>Hint</td>
<td>In this mode, the program displays the identification of an entity that the point of the arrow touches. To change to this mode, click on the Hint Mode Tool</td>
</tr>
<tr>
<td><img src="image" alt="Creation" /></td>
<td>Creation</td>
<td>In this mode, the program will create an entity, such as a line, column or slab. Place the cross at the location where you want the entity to be created and left-click the mouse. Detailed instruction for creation of each entity will be prompted on the User Information Bar at the bottom of the screen. To enable Creation Mode, left-click the mouse on the tool of the entity you intend to create. Then follow the instructions at the bottom of the screen.</td>
</tr>
<tr>
<td><img src="image" alt="Snap" /></td>
<td>Snap</td>
<td>In this mode, the magnet indicates that the cursor is in Snap Mode and is searching to snap onto an entity. The cursor will search for one or more entities. Once the cursor becomes close to any of the entities or conditions it is searching for, it will display a yellow sign over the location to be snapped. The shape of the yellow sign displayed identifies the entity for snapping.</td>
</tr>
<tr>
<td><img src="image" alt="Undefined Creation" /></td>
<td>Undefined Creation</td>
<td>In this mode, the program can be requested to create an entity, although the plane on which the entity is to be created is not displayed. You must change the screen view (go to Plan View, if you are in Elevation) before you can create the entity in mind.</td>
</tr>
</tbody>
</table>
1.4 OPERATION OF RETURN AND TAB KEYS

A special function assigned to the Return key is to repeat the last operation performed – when the duplication of such operation is practical. For example, if you use the Copy command to copy an entity, pressing the Return key will invoke the Copy command again.

In addition to its normal function, the Tab key can help you select an individual item in a group of similar items that overlap. When you attempt to select items that overlap, such as several beams intersecting at the same location, the mouse click on its own is not adequate to identify the beam of your choice. The program will select one and change its color. If the program’s selection is not the one you intended, click the Tab key. The program will select and display the next item. Continue clicking the Tab key, until the item of your choice is selected.

1.5 OPERATION OF KEY COMBINATIONS

Some key combinations act as shortcuts to pre-assigned operations. The key combinations are generally displayed on the computer screen, next to the menu items they represent. The most commonly used combinations are:

- **Copy**   Ctrl key + C
- **Move**   Ctrl key + M

1.6 HOW TO END/CLOSE AN OPERATION

To end or close an operation, such as closing a polygon, press the Close/End/Accept, or C key.

1.7 HOW TO ABANDON AN OPERATION

To abandon an operation you have already started, such as drawing a polygon, press the Esc key.
1.8 MAIN MENU

All options that can be accessed by the main program menus are listed below.

1.8.1 File Menu

Some of the File Menu operations are:

**Save As Version.** This option saves an existing ABI .abi file as an older version of the .abi file so that it is operable with earlier versions of the program.

- **Save As v4 INP.** This option saves an existing ABI INP file as an ABI v4 INP.
- **Save As v5.00.2.** This option saves an existing ABI INP file as an ABI v5.00.2 INP.
- **Save As v2009.01.** This option saves an existing ABI INP file as an ABI v2009.01 INP.

**Save As Default Values.** Once you save data using this option, the program will open all the future new projects using the values in the data you saved. To change the default values, open a new file, modify the parameters of your choice, and re-save it using Save As Default Values.

**Automatically Save Option.** As a safeguard against lost data, the program automatically saves your file at the intervals stated in the dialog window of Fig. 1.8-1. The data is saved using the original name preceded by a ~ character. In the event of data loss, erase the ~ character from the name of the saved data before attempting to open it.

![Automatically Save Options Dialog Window](image)

**FIGURE 1.8-1 AUTOMATICALLY SAVE OPTION DIALOG WINDOW**
**Import and Export of Files.** You can import/export an AutoCAD file, or import generic ADAPT files (v4 INP file). When selecting any of these options, you will be prompted to browse the location of the file you would like to import.

### 1.8.2 Edit Menu

Edit menu operations (Cut, Copy, Paste, Undo, Redo) are standard Windows commands and will not be explained here.

**Items property.** This menu item opens the property box of the selected item. For example, if you select a frame element cell and click on Edit->Items Property the Concrete Cell property box will open as shown in **Figure 1.8-2**. This menu item has the same function as Item’s Property tool, in the Selection toolbar.

![Concrete Cell Dialog Window](image)

**FIGURE 1.8-2 CONCRETE CELL DIALOG WINDOW**

### 1.8.3 View Menu

The View menu operations are:

**Redraw.** This menu item clears and then re-draws the entire display. The corresponding tool is located in Camera and Viewport toolbar.

**Zoom.** This menu item enables you to zoom in or out. The submenu items have same functions as corresponding tools in the Camera and Viewports toolbar.
**Pan.** This menu item enables you to pan your model. The corresponding tool is located in the camera and Viewport toolbar.

**Select Display Item.** This menu item enables you to set the display of the project items on the screen. The corresponding tool is located in the Selection toolbar.

**Select/Deselect View by Type.** This menu allows you to select specific items or all items for viewing on the screen. The corresponding tools are located in the Selective View toolbar.

**Select/Deselect Label Display.** This menu enables you to display/hide labels on selected items or all items. The corresponding tools are located in the Selective View toolbar.

**Display WCS.** This menu item allows you to display or hide the World Coordinate System icon at its real position in (0,0,0). The corresponding tools are located in the Settings toolbar.

**Viewport.** This menu enables you to create one or more independent viewing ports on the screen. The corresponding tools are located in the Viewport toolbar.

**Undo Camera Direction.** This menu item enables you to undo the last zoom/pan operation. The corresponding tool is located in the Camera and Viewport toolbar.

**Redo.** This menu item enables you to recover your last zoom/pan operation. The corresponding tool is located in the Camera and Viewport toolbar.

**Project Browser/Event Manager.** This menu item enables you to display/hide the Project Browser and Event Manager on the screen.

### 1.8.4 User Interface Menu

This menu contains the list of all toolbars available in the main program window. To display a toolbar, click on the User Interface menu and select the toolbar from the list.
1.8.5 Settings Menu

The Settings Menu operations are:

Environment. This menu item enables you to set the font and size of the text as well as to set the gridlines on the screen. The submenu items are as follows:

- **Text.** The Text setting controls the font and size of the text displayed on the computer screen. When invoked, the following dialog window gives you access to the text settings.

![Text Settings Dialog Window]

- **Grids.** This tool opens the Grid Settings dialog box where grid spacing, angle and other parameters can be set. This option is also available in Snap toolbar.

Drawings. This menu item enables you to set up the line types, colors and layers in the program. The submenu items and corresponding tools accessed from the Settings menu are as follows:

- **Layer Setting.**
- **Line Style Setting.**
- **Colors Setting.**

General Settings. The General Settings menu item opens the dialog window of Fig. 1.8-4. The Cursor and Scroll Bars tabs control the display on the screen. The functions listed on the Misc. tab are self-explanatory. The last check box is used to set the parameters of the entity you want to create. If selected, the program will use the last modification you make in the property window of an entity, such as column, when you generate the next entity of the same type, such as column. Obviously, you can go back and edit the dimensions.
**FIGURE 1.8-4 GENERAL SETTINGS DIALOG WINDOW**

**Distortion Scale.** The Distortion Scale menu item opens the dialog window of Fig. 1.8-5. You can change the scale of the display along any of the two principal axes (X or Z) in order to obtain a clearer view of the structure.

![Distortion Scale Dialog Window](image)

**FIGURE 1.8-5 DISTORTION SCALE DIALOG WINDOW**

**Grouping.** Each entity, such as a column, or a rebar, belongs to a Group and has a unique name, or Label.

The concept of the Group is used to give you the option to select specific items for display or other operations. For example, if you want to display only selected elements; you can Group them as one, give them a Label and display only members of that Group.

Initially, every item you create will be placed in Group 1. But you can modify the Group assignment of the item and bring it to the Group of your
choice. When you click on the Grouping the following dialog window opens (Fig. 1.8-6). You can add a Group or delete one, make a Group visible or hide it.

![Grouping Dialog Window](image)

**FIGURE 1.8-6 GROUPING DIALOG WINDOW**

**View Structural Entities.** This menu is used to display/hide different components and has the same function as Structural Components/Aids Display Toolbar.

1.8.6 Tools Menu

**Snap.** This menu contains all the snapping tools of the program. It has the same function as the Snap toolbar.

**Measure.** This menu item enables you to Measure the distance between any two points on the computer screen. Click on the menu and follow the instructions at the bottom of screen.

**Coordinates.** Click on this menu item, select a point and read its values at the bottom of the screen.

**Selection.** This menu item contains all tools related to selecting specific elements, objects and structural components in the model. The submenu items have the same function as corresponding tools in Selection toolbar. Additional options are Select None and Delete Selection.

**Add/Remove Points.** This menu item adds or deletes the currently selected vertex of an entity. The submenu items have the same function as corresponding tools in Selection toolbar.
**Blocks.** This menu item creates a block containing all entities currently selected or breaks down a previously created block into its component. The submenu items have the same function as corresponding tools in the Selection toolbar.

**UCS.** This menu item is used to specify the position of items on the screen by coordinates. It has the same function as the UCS toolbar.

**Calibrate Drawing.** This menu is used to change the scale of the entire project. Click on this menu item and follow the instructions at the bottom of the screen. The primary application of this tool is to calibrate an imported drawing, such as a DWG file. If you wish to scale only a portion of the project, you need to use the Scale Selected Items tool from the Modify pull-down menu.

**Change Project Origin.** If you want to change the origin of the coordinate system, select this item and follow the instructions at the bottom of the screen.

**Calculator.** This menu item displays calculator.

### 1.8.7 Modify Menu

The Modify menu operations are described below:

**Properties.** If you select an entity and click on the Properties menu item, the Modify Properties dialog box opens and allows you to modify the display characteristics of the entity you selected on the screen (Fig. 1.8-7).

![Modify Properties Dialog Window](image)

**FIGURE 1.8-7 DISPLAY PROPERTY DIALOG WINDOW**

**Copy/Move.** This menu item enables you to create single or multiple copies of the entities that are currently selected. It has the same function as corresponding tools in Copy/Move toolbar.
Mirror. This tool creates a mirror image of the entities you select about the line of your choice. Select one or more items to mirror, click on the Mirror tool and follow the instructions at the bottom of the screen.

Extend. This tool elongates the length of a line to reach another line of your choice. To perform this operation, select the line that you want to extend, click on the Extend tool and follow the instructions at the bottom of the screen.

Trim. Use this tool to erase the extension of a line beyond its cross-section with a second line. Pick the line you wish to trim, click on the Trim tool and follow the instructions at the bottom of the screen.

Join. This tool joins two intersecting lines into one.

Split. This tool subdivides the length of a line, beam, wall or any other linear entity into a number of equal lengths specified by you. Select an entity, click on the Split menu item to open the dialog window shown in Fig. 1.8-8. Enter the number of divisions.

![Split the Linear Entity](image)

**FIGURE 1.8-8 SPLIT THE LINEAR ENTITY DIALOG WINDOW**

Modify Item Properties. If you want to change the properties of a number of entities at one time – for example, you want to change the size of several columns – use the Modify Item Properties. Select the individual entities you want to modify, then click on Modify Item Properties. The following dialog window appears. Select the tab that relates to the entities you want to modify, such as columns. Make the modifications on the data fields of the tab. Press OK to implement your changes. The corresponding tool is located in the Modify Selection toolbar.
FIGURE 1.8-9 MODIFY ITEM PROPERTIES DIALOG WINDOW

**Refresh.** This menu item clears and then re-draws the entire display. It has the same function as corresponding tool in the Camera and Viewports toolbar.

**Modify Point Support.** This menu item allows you to modify the fixity of already created point supports. It has the same function as Point Support toolbar.

**Unsplit.** This tool recombines the segments of an entity that was formerly split into pieces, using the Split tool.

**Scale Selected Items.** Use this menu item if you want only selected entities of your project to be scaled. Select the entities to be scaled. Click on the Scale Selected Items menu, and follow the instructions on the dialog window that appears.
1.8.8 Material Menu

You can access the input dialog box for material properties from the Materials pull down menu. It has three menu items as follows:

**Concrete.** Select Concrete menu item to open the materials input dialog box (Fig. 1.8-10). In this dialog window, you can select concrete model and define one or more concrete material properties. Each concrete material will have its own Label. The program will give a label to each material you add to the list, but you have the option of changing the label.

![Concrete Material Dialog Window](image)

**FIGURE 1.8-10 CONCRETE MATERIAL DIALOG WINDOW**

If User defined concrete model option is selected you can input the shrinkage, creep and change of modulus of elasticity with time (Fig. 1.8-10 (A)). You have to define shrinkage curve and at least one creep curve with minimum of three readings for each curve.

To define shrinkage curve enter in the Age (days) column age of concrete in days when shrinkage readings are taken and in the Shrinkage strain column enter the value of shrinkage strain. Minimum age is 1 day.
Click Add button to add creep curves. For each creep curve enter the following data:

- Loading age - age of the specimen in days when the creep loading is applied. Minimum age is 1 day.
- Modulus of elasticity - modulus of elasticity of the specimen at the time the creep loading is applied.
- Age (days) - Days when measurements of the creep specimen are made, minimum age is 1 day.
- Creep strain

Once you complete shrinkage and creep data input type the name of the concrete model in the Label field and click Apply button to save it. You can specify more than one user-defined concrete model.

You have an option to export shrinkage and creep data to an external text file and save it for later use in other ABI models. To do so click on the
Export Data button and specify the name and location where you want to save the file. The program will create the file that will contain shrinkage and creep data for all user defined concrete models you created. The file is a text file and you can edit it if needed. To import creep and shrinkage data from the external text file click on Import Data and browse to the location where you saved the text file. The program will import all the user defined concrete models from the file.

**Prestressing.** You can enter the material properties for prestressing steel in the input dialog window shown in Fig. 1.8-11.

![Prestressing Material Dialog Window](image)

**FIGURE 1.8-11 PRESTRESSING MATERIAL DIALOG WINDOW**

**Cable Stay.** You can define material properties of the different stay elements. The properties that you need to specify are listed in Fig. 1.8-12.
FIGURE 1.8-12 CABLE STAY MATERIAL DIALOG WINDOW

Analysis option button is used to control type of analysis to be performed (Fig. 1.8-13). The cable stay element formulation allows geometry as well as sag nonlinearities to be included in solution.

FIGURE 1.8-13 CABLE STAY ANALYSIS OPTIONS DIALOG WINDOW
**Mild Steel.** Non-prestressed steel is grouped in the Mild Steel category for input data. The properties that you need to specify are listed in **Fig. 1.8-14.**

![Figure 1.8-14 Mild Steel Material Dialog Window](image)

**Figure 1.8-14 Mild Steel Material Dialog Window**

1.8.9 **Moving Load Menu**

The input data for the moving load module is defined through the Moving Load menu item.

**Moving Load Library.** When you select this menu item the program opens the Load Train Library dialog window (**Fig. 1.8-15**). This window contains the names and definitions of all AASHTO, IRC and BS 5400, and European Code (EC) moving load trains. Alternatively, you can create new load trains from the available load types shown in **Figure 1.8-15.**
Travel Path. This menu item allows you to create travel path(s). To define a travel path do the following:

- Ensure you are in the Developed View.
- Click on Moving load -> Travel path.
- Enter the first and second point of a line with your mouse along your structure. This defines the first sector of a travel path. If you want to define multiple sectors, enter additional points.

You can modify a travel path through its property box (Fig. 1.8-16). Under Skipping option, you can skip individual sectors.
Load Case. A “Load Case” is defined as the application of one or more load trains to a user-specified “Travel Path(s)”. You can create a load case through the Moving Load Case dialog window as shown in Fig. 1.8-17.

1.8.10 Model Menu

The Model menu operations are described below:
**Gridline.** This menu item allows you to create custom gridlines. It has the same function as Gridline toolbar.

**Structural Components.** This menu item enables you to create structural components. It has the same function as the Model toolbar.

**Transform Drawing Entities.** This menu item enables you to convert the items shown on the drawing to Structural Components for your model. It has the same functions as the Transform to Structural Components toolbar.

**Bridge Wizard.** This menu item takes you through a five-step wizard that allows you to quickly create a straight bridge with existing cross sections and uniform loads.

### 1.8.11 Build Menu

This menu item enables you to add structural components at selected construction steps and also view/edit the construction sequence. It has the same function as the Build/Assemble Structure toolbar.

### 1.8.12 Loading

The Loading menu operations are described below:

**Add Load.** This menu item enables you to add point load, line load, selfweight and temperature loading. It has the same function as the Load toolbar.

**Display Load.** This menu gives you an option to display loads of selected stage or all loads. It has the same function as corresponding tools in the Load Report toolbar.

**Load Case Library.** This menu item enables you to define load cases. Once clicked, the dialog box shown in Figure 1.8-18 opens. To create a load case click on the Add button. A new load case will appear on the list. Click on it if you want to change its name (label). The letter “V” in front of the load case names in the list indicates whether or not the loads of that load case can be viewed on the screen.
Seismic Load Case Library. In ADAPT ABI seismic analysis is based on Pseudo Static Method in which the inertia forces due to earthquake are represented by a force in horizontal or vertical direction equal to the weight of the structure multiplied by a seismic coefficient.

Once you click on Seismic Load Case Library menu option, the dialog box shown in Figure 1.8-19 opens.

To create seismic load case follow the steps:

- Define Label.
- Select horizontal or vertical direction option to create inertia force in horizontal or in vertical direction.
- Enter value of seismic coefficient.
- Define total weight of the structure to be considered in calculation of inertia forces:
  - You have an option to include/exclude selfweight.
  - To add additional loads, select load case from the drop-down list, define load factor and click Add. The Load will appear in the list.
- Click Add New button. The load will appear in the list of seismic load cases.
To modify seismic load case, follow the below steps:

- Select seismic load case from the list.
- Enter modifications.
- Once completed click Update button.

Seismic load cases will be available in Load Combinations/Envelopes dialog window and you will be able to include them in load combinations.

**Load Combinations/Envelopes.** This menu item enables you to create load combinations and envelopes. Once clicked, the Combinations dialog window opens (*Fig. 1.8-20*). To define a load combination, follow the steps:

- Specify load factors in front of load case/combination you would like to include in load combination.
- Click Create Load Combination button.
• Load combination appears in the combinations list as Combination 1. To rename load combination click on the name and retype it.

To define an envelope, follow the below steps:

• Select load cases/combinations from the list.
• Click Create Envelope button.
• Envelope appears in the Envelopes list as Envelope 1. The load factors are not included. To rename envelope click on the name and retype it.

FIGURE 1.8-20 COMBINATIONS DIALOG WINDOW
1.8.13 Process

This menu enables you to mesh a structure, create and validate input data, run analyses and display results. The Process menu operations are described below:

Create Mesh. When you select this menu item the dialog window shown in Figure 1.8-21 opens. Do the following:

- Specify cell size.
- If you modeled a composite structure check the Composite analysis option.
- Click OK.

The program creates mesh and divides structural components into cells. A finite element mesh is only created for segments and columns / piers.

![Automatic Mesh Generation Dialog Window](image)

**FIGURE 1.8-21 AUTOMATIC MESH GENERATION DIALOG WINDOW**

Clear Mesh. This menu item deletes already created mesh.

Generate Input Data. The program creates INP file with information about the structure you previously modeled including load combinations but excluding moving load information. This is the input file for ABI-Basic and ABI-GEN module.

Generate Input Data for Moving Load. The program creates a MOV file with information about moving load. This is the input file for ABI-Moving Load module.
**Options.** This menu enables you to add automatic restraints between Piers and Segments if the checkbox is selected. If the checkbox is unselected, the program will not add restraints and the user must manually add these to ensure proper fixity.

**Execute.** This menu item activates ABI-Basic module calculations and ABI-GEN module calculations.

**Execute Moving Load.** This menu item activates ABI-Moving Load module calculations.

**Execute Elongation.** The program runs the Elongation module and calculates elongation and losses in tendons.

**Edit Input Data.** This menu item enables you to open the INP file. This file is in text format and you can modify it if needed.

**Edit Moving Load Input.** This menu item enables you to open the MOV file. This file is in text format and you can modify it if needed.

**View Results.** This menu item opens the three-dimensional viewer of the program where you can view and examine the results graphically.

### 1.8.14 Report

The Report menu operations are described below:

**Geometry and Analysis Results.** This menu item opens a report that includes input data as well as calculated results. Report is in text format.

**Torsion Report.** This menu item opens a report that includes calculated results for torsion. Report is in text format.

**Friction/Elongation Summary Report.** This menu item opens a summary report for friction/elongation calculation. Report is in text format.

**Friction/Elongation Detailed Report.** This menu item opens a detailed report for friction/elongation calculation. Report is in text format.

**Report Generator.** This menu item allows the user to generate customized reports from predefined categories. Report templates can be
created and saved as default report types. Reports are generated as .rtf files and opened in the user’s default word processing program.
Chapter 2

TOOLBARS AND DIALOG WINDOWS

2.1 MAIN TOOLBAR ............................................................................................................... 33
2.2 SETTINGS TOOLBAR ...................................................................................................... 34
2.3 SELECTION TOOLBAR .................................................................................................. 34
2.4 CAMERA AND VIEWPORTS TOOLBAR ..................................................................... 39
2.5 SELECTIVE VIEW TOOLBAR ...................................................................................... 40
2.6 SNAP TOOLBAR ............................................................................................................ 41
2.7 DRAW TOOLBAR AND DRAW MINI TOOLBAR .......................................................... 43
2.8 GRIDLINE TOOLBAR ................................................................................................... 47
2.9 COPY / MOVE TOOLBAR ............................................................................................ 48
2.10 SCALING TOOLBAR ................................................................................................... 49
2.11 UCS TOOLBAR ............................................................................................................. 50
2.12 VIEWPORT TOOLBAR ................................................................................................ 50
2.13 TRANSFORM TO STRUCTURAL COMPONENTS TOOLBAR .................................... 51
2.14 MODEL TOOLBAR ....................................................................................................... 52
2.15 POINT SUPPORT TOOLBAR ....................................................................................... 62
2.16 BUILD/ASSEMBLE STRUCTURE TOOLBAR ............................................................ 63
2.17 TRAVELER TOOLBAR ............................................................................................... 65
2.18 OFFSET AND RERAINT TOOLBAR ............................................................................. 65
2.19 LOAD REPORT TOOLBAR .......................................................................................... 66
2.20 LOAD TOOLBAR .......................................................................................................... 66
2.21 REFERENCE LINE TOOLBAR .................................................................................... 69
2.22 SPAN/COLUMN TOOLBAR ......................................................................................... 70
2.23 SPRING TOOLBAR .................................................................................................... 70
2.24 CELL TOOLBAR .......................................................................................................... 71
2.25 TENDON/STAY TOOLBAR .......................................................................................... 71
2.26 MODIFY SELECTION TOOLBAR ................................................................................ 72
2.27 STRUCTURAL COMPONENTS/AIDS DISPLAY TOOLBAR ......................................... 72
2.1 MAIN TOOLBAR

The Main toolbar for ADAPT-ABI contains tools common to all Windows-based programs. Such tasks as starting a new file, saving, cutting and pasting, undoing and redoing previous commands, and printing all can be accomplished from this toolbar. Most of these functions may also be completed from the associated File or Edit menu items. The tools are:

- New (CTRL+N)
- Open (CTRL+O)
- Save (CTRL+S)
- Cut (CTRL+X)
- Copy (CTRL+C)
- Paste (CTRL+V)
- Undo (CTRL+Z)
- Redo (CTRL+Y)
- Print (CTRL+P)
- Help File
2.2 SETTINGS TOOLBAR

This toolbar is used to set up the Universal Coordinate System, line types, colors and layers in the program. The settings are also accessed from the Settings menu.

Layer Setting. The color and line settings for each layer can also be modified in this window.

Line Style Setting. Click on this tool to open a list of the available line styles and descriptions. Select the line style of your choice.

Colors Setting. This tool opens a color palette, from which you can select the background of the modeling window.

Display WCS. This toggle tool displays or hides the World Coordinate System icon at its real position in (0,0,0).

2.3 SELECTION TOOLBAR

This toolbar contains all tools related to selecting specific elements, objects and structural components in the model, and also the tools for selecting the entities that you want to be visible on the screen. Each tool is described below.

Select/Set View Items (Fig. 2.3-1). This button is used to set the display of the project items on the screen. Depending on which boxes you select, you can display additional information about each entity. The size of the symbols representing each entity, and the font that expresses the information is controlled by the Symbol Size and Font Height data fields. The font size for each entity can be controlled individually. If the information displayed on the screen overlaps, you can select text and move it around to increase the clarity of display.

You can control which graphical components are displayed on screen using the checkmarks under the Display column.
**FIGURE 2.3-1 GRAPhICAL COMPONENTS DIALOG WINDOW**

**Hint Mode.** When activated, the arrow displays the identification of the entities to which it points. In this mode you cannot select an entity by clicking on it.

**Window Selection.** When this tool is highlighted, the Pick/Select mode is active. You can select a single entity by clicking on it, or a group of entities by opening a window around the items while the left mouse key is held down.

Double-clicking on an entity opens its properties dialog box.
**Lasso Selection.** This tool allows you to draw an arbitrary polygon around a series of entities. When the lasso is closed, all entities located within or along the lasso perimeter are selected. To use this tool, do the following:

- Click on the Lasso Selection tool.
- Draw segments of the polygon around the entities to be selected.
- Press C to close the lasso. The entities inside the lasso are selected automatically.

**Path Selection.** With this tool you can select entities by drawing a polyline through them. To use this tool, do the following:

- Click on the Path Selection tool.
- Draw a polyline through the entities to be selected.
- Press C to end the line. The entities through which the line passes will be selected automatically.

**Select by Layer.** This tool enables you to select all the entities on a specific layer of the drawing. To use the tool, do the following:

- Click on the Select by Layer tool. The dialog box shown in **Fig. 2.3-2** will open.
- Select a layer from the list. If more than one layer is to be selected, hold down the Ctrl key while selecting from the list.
- Choose the selection type from the check boxes at the bottom of the dialog box and press OK. The items on the layers chosen from the list will be selected, or removed from selection, depending on the option chosen.
FIGURE 2.3-2 SELECT LAYERS DIALOG WINDOW

**Select by Type.** This button is used to open a dialog box (Fig. 2.3-3) in which one or more component types can be selected as a group. For example, all columns or all support lines can be selected at once. To use the tool, do the following:

- Click on the Select by Type tool. The dialog box below will open.
- Select an entity type from the list. If more than one type is to be selected, hold down the Ctrl key while selecting from the list.
- Choose the selection criteria from the check boxes at the bottom of the dialog box and press OK. Entities of the type chosen in the list will be selected, or removed from selection, depending on the option chosen.
Select All. This tool selects all the entities visible on the screen.

Move Selection. This tool enables you to move the entire group of entities that are currently selected. Pick a vertex of one of the entities in the selection and drag the entire group to the new location.

Move Selected Point. With this tool you can move only the vertex of an entity to a new location, while the positions of the remainder of the entity’s vertices remain unchanged. Select the entity first. Then pick the vertex you wish to move. Drag it to the new location. The selected vertex will move independently; all other vertices will remain in their original location.

Delete Point. This tool deletes the currently selected vertex of an entity.
**Insert Vertex.** This tool is used to insert an additional vertex into an entity that contains multiple insertion points. The new vertex is placed between the selected vertex and the previous vertex. If the first vertex is chosen, then the new vertex is added at this end. To add a vertex, do the following:

- Select the entity.
- Click on the Insert Vertex tool.
- Click on one of the entities’ vertices. Another vertex will be added to the entity, adjacent to the selected vertex.

**Item’s Properties (Alt + Enter).** This tool opens up the Properties dialog box for the selected entity. The properties may then be edited.

**Group Selection.** This tool creates a block containing all entities currently selected. The block may then be dragged as one unit across the screen.

**Explode Block.** This tool breaks down a previously created block into its component. It also works with blocks of imported DWG or DXF files.

### 2.4 CAMERA AND VIEWPORTS TOOLBAR

This toolbar is used to display different views of the model, to zoom in or out, pan or show multiple port views of the structure. The tools on the toolbar are self-explanatory. The roll-over hint text associated with each tool provides additional information. The following describes several of the less commonly used tools.

**Redraw.** This button clears and then re-draws the entire display.

**Developed View.** This tool shows a developed view of the model. In this view the user is able to create structural components and view tendons.

The following buttons display the model from different angles.

**Top View**

**Left View**
Chapter 2  TOOLBARS AND DIALOG WINDOWS

Front View

Top-Front-Right View

Other tools are:

Zoom Window

Zoom Extents

Zoom In

Zoom Out

Dynamic Zoom

Dynamic Pan

Undo Zoom / Pan

Redo Zoom / Pan

Single Viewport

Two Vertical Viewports

2.5  SELECTIVE VIEW TOOLBAR

Display Items by Type. This tool allows you to select specific items for viewing on the screen. Simply click on the tool. It opens a list of items in your project. Select the items you want to be visible and press OK.

Display All Items. This tool makes all the items in your project visible.

Display Labels on Selection. This tool displays labels of the items you select.
Display All Labels. This tool displays the labels of all items currently visible on the screen.

2.6 SNAP TOOLBAR

This toolbar contains all the snapping tools of the program. To snap to an entity, the mouse must be in Select/Pick mode, and you must bring the cursor close to the location where you will snap the entity. Left-click the mouse to snap. The options are:

- **Snap to Endpoint**
- **Snap to Midpoint**
- **Snap to Center**
- **Snap to Intersection**
- **Snap to Perpendicular**. This tool forces the mouse cursor to snap to a target entity, such that the entity being created will be positioned perpendicular to its target.
- **Snap to Nearest**
- **Snap to Grid**. This tool forces the mouse cursor to snap to the nearest grid point.
- **Grid Settings (Fig. 2.6-1)**. This tool opens the Grid Settings dialog box where grid spacing, angle and other parameters can be set.
FIGURE 2.6-1 GRID SETTINGS DIALOG WINDOW

**Snap Settings (Fig. 2.6-2).** This tool opens the Snap Settings dialog box, where all snapping features may be selected or deselected.

FIGURE 2.6-2 SNAP SETTINGS DIALOG BOX
Snap to Vertices of a Component. Using the previously described tools, you will not be able to snap arbitrarily to the vertices or edges of structural components, such as a beam. Since a structural component that is displayed as solid is defined by its insertion points, the insertion points will not necessarily be the vertices or edges of the entity. By clicking on the above tool, you can make the vertices and edges of all the structural components of your project capable of being snapped to.

Note: Caution should be used when working with this tool. In order for a structural component to be correctly accounted for, in most instances it must be connected to other structural components through its insertion point. That is to say, the components must snap together at their insertion points.

Create/Draw Orthogonal. This tool forces the entity being drawn or created to be positioned along either the X-axis or Y-axis.

2.7 DRAW TOOLBAR AND DRAW MINI TOOLBAR

The tools remain active for multiple-entity generation until you press the Esc key, or right-click on the mouse. To edit an existing drawing entity, double-click on it to open its property box.

Continue Mode. This tool allows you to create linked entities without having to draw the entities separately. For example, if you want to create a series of beams that are connected at each support location, you can invoke this mode, and each new beam in the series will be connected to the last insertion point of the last created beam.

Create Point. To create a point with this tool, do the following:

- Click on the Create Point tool, and insert the point at the location you choose with the mouse.
• To change the location of the point, double-click on the point to open its property box (Fig. 2.7-1). Edit the coordinates. Other drawing entities can be edited in a similar manner.

FIGURE 2.7-1 PROPERTY BOX OF A POINT

Create Line.
Create Polyline.
Create Polygon.
Polygon: Vertices, Center, Radius.
Polygon: Vertices, Start Edge, End Edge.
Polygon: Vertices, Diameter.
Circle: Three Points.
Circle: Diameter.
Circle: Center, Radius.
Arc: Three Points.
Arc: Radius, Angle.
Arc: Start, Center, End.
Arc: Start, End, Radius.
Arc:  Radius, Chord.

Write Text, Select Position. This tool creates text by specifying the text content, starting point, font height and direction. To create text with this tool, do the following:

- Click on the Text tool. Follow the instructions in the User Information bar.
- Write the text, click on the start point, enter the font height of the text and choose the direction.

To edit previously written text:

- Double-click on the text. The corresponding dialog box will open (Fig. 2.7-2).
- Edit the font, height, coordinates and other parameters as necessary.
- Click on the □ button to accept the new input values.
- Alternatively, to change location of the text just drag the insertion points to their new locations.

![Text Properties](image)

FIGURE 2.7-2 TEXT EDITING DIALOG BOX

Select Position, Write Text. This tool creates text by specifying the start point, specifying font height, choosing a direction and entering the text. To create text with this tool, do the following:
• Click on the Text tool. Follow the instructions in the User Information bar.

• Write the text by clicking on the start point, entering the font height of the text, choosing the direction, and finally typing the text.

To edit previously written text, follow the same procedure as for the preceding text creation option.

Create Dimension Line. This tool creates a dimension line by specifying the start point, end point and position of the dimension line. To create text with this tool, do the following:

• Click on the Create Dimension Line tool. Follow the instructions in the User Information bar.

• Click the start point, click the end point and choose the position of the dimension line.

You can change the size and font of the text on the dimension lines by modifying the default values in the Text dialog box. You can access this dialog box from the Settings pull-down menu under Environment menu items.

To edit a previously created dimension line:

• Double-click on the dimension line. Its dialog box will open (Fig. 2.7-3).

• Edit as necessary.

• Click on the button to accept the new input values.

• Alternatively, just drag the insertion points to their new locations.
2.8 GRIDLINE TOOLBAR

Gridline Wizard. This tool opens a dialog box to create a series of gridlines with user-defined spacing and labels. Specific input controls are described below. Once the gridlines are created, you have the ability to edit them. You can change the position, orientation, length and label of each gridline individually (Fig. 2.8-1).

Draw User-Defined Gridlines. To draw the gridline, click on the tool and follow the instruction at the bottom of the screen. Once the gridline is
created you have the ability to edit it. Double click on the gridline to open its property box (Fig. 2.8-2) and change the default settings.

![Gridline Property Box](image)

**FIGURE 2.8-2 GRIDLINE PROPERTY BOX**

### 2.9 COPY / MOVE TOOLBAR

This toolbar enables you to create single or multiple copies of the entities that are currently selected, either as a linear or circular array of identical entities. You can replicate the selected entities with the mouse (graphical) or by coordinates.

- **Graphical Translation.** This tool moves or copies an entity horizontally (in the X- or Y- direction). Select one or more entities you want to act on and follow the instructions on the screen.

- **Graphical Rotation.** This tool rotates an entity in the X-Y plane around a point specified by you. Select one or more entities you wish to rotate and follow the instructions on the screen.

- **Translation by Coordinates.** This tool opens a window where any one of the choices of the Copy/Move toolbar can be selected (Fig. 2.9-1). The operation, however, takes place when you enter the coordinates of the location where you want the selection to be copied/moved.
Layer Translation. This tool copies or moves the selected item(s) from one drawing layer to another. Select the items you wish to copy/move, click on the tool and follow the instructions on the screen.

Note: Moving an item from one layer to another may affect how other display tools perform. For example, if a column is moved from its original layer to a different layer, then that column no longer will be controlled by the Display Column tool.

2.10 SCALING TOOLBAR

This toolbar provides you with the option of distorting the dimension of the model in one or more direction, in order to obtain a better view of its details, such as magnifying the profile of a tendon within a slab thickness. Select any of the three coordinate axes, X, Y or Z. Then click on the button of your choice, such as Increase Scale Factor. With each click, the program reduces or increases the scale of the entire display along the selected axis. The function of the tools is as follows:

Decrease Scale Factor

Reset Scale Factor. This tool resets the scale factor to 1 for the chosen coordinate direction.
2.11 UCS TOOLBAR

The User Coordinate System toolbar offers the following choices for specifying the position of items on the screen by coordinates.

- **World Coordinate System.** This tool changes User Coordinate System (UCS) to the World Coordinate System (WCS) – the default setting of the program.

- **UCS at Last Point.** The UCS positions the origin of the coordinate system at the last point entered. But, the direction of the X-axis and Y-axis remain parallel to the global axis (WCS).

- **UCS at Endpoint of Last Line.** The UCS is positioned at the endpoint of the last line segment entered, with the X-direction along the previously drawn line.

- **UCS: 5 Points.** The UCS is defined by: Origin, X Start, X End, Y Start, Y End.

- **UCS: 3 Points.** The UCS is defined by: Origin, X End, Y End.

2.12 VIEWPORT TOOLBAR

Viewport tools create one or more independent viewing ports on the screen. Each icon shows the orientation on the screen of viewports created by that tool. To
create one of the views, just click on its tool. These viewports may also be printed.

2.13 TRANSFORM TO STRUCTURAL COMPONENTS TOOLBAR

You will use this tool if you start with a DWG or DXF file, and plan to convert the items shown in the drawing to Structural Components for your model. In other words, if you are not importing a drawing for conversion to your model, you are not likely to use the tools on this toolbar. You will use the Build toolbar.

Once you import a DWG or DXF drawing, your first choice is to transform the items in the imported drawing directly to structural model. The items shown in the imported drawing are simply lines (graphics). The process of conversion is to (1) pick an item in the drawing, such as a column, and (2) click on the associated structural component tool (Transform to Column), in order to convert it to a structural component.

Transform Selected Polygons into Sections Select any closed polygon that you would like to transform into a cross section and click on this button. A message will be displayed after successfully converting the polygons. The cross sections can then be managed in the Section Manager. Only the items that are in the form of a closed polygon can be selected and converted.

Transform Polygon Only items that are in the form of a closed polygon can be selected and converted directly into structural components. Not every column or opening in the imported structural drawing is drawn as a closed polygon.

This button is used to transform groups of lines that are drawn separately, but intersect into a polygon. Click on the tool. The program searches the drawing and creates polygons for the instances where conversion of intersecting lines into polygons is practical. The program retains the original items on the drawing, but writes the polygons created in a new layer called “Polygons_from_line.”
Transform Polygon into Cell. This button is used to transform a polygon (closed polyline) into a cell. The tool operates in the same manner as the Transform Column tool, which is described in greater detail below.

Transform Polygon into Pier/Column. This tool is used to transform a rectangle (polygon) or circle to a column.

To transform a (polygon) rectangle into a column do the following:

- Select one or more rectangles that are made up of polygons.
- Click on the Transform Column tool. All selected entities will be transformed into columns with the same dimensions as the rectangle or circle.

Transform an Entity into Tendon. This button is used to transform a line into a tendon. The tool operates in the same manner as the Transform Column tool.

Transform Stay. This button is used to transform a line into a stay. The tool operates in the same manner as the Transform Column tool.

Transform Lines into Reference Line. This button is used to transform a line into a reference line. The tool operates in the same manner as the Transform Column tool.

Transform Polygons into Segment. This button is used to transform a polygon (closed polyline) into a segment. The tool operates in the same manner as the Transform Column tool.

2.14 MODEL TOOLBAR

The primary application of this toolbar is to create a structural model from scratch as opposed to using an imported DWG/ DXF file. In addition, it works as a supplement to the Transformation tool described in the preceding, since not all
Structural Components can be transformed directly from an imported file. You may have to create some of them manually, using the tools of this toolbar.

For a major real-life structural model, you are likely to start by setting out some gridlines, and/or use a grid on the background to help you in your drafting. For this purpose, use the Gridline Toolbar described earlier in this manual.

Create Reference Line. This tool enables the user to draw reference line.

Create Segment. This tool creates a new segment with the corresponding properties in the dialog box shown in Figure 2.14-1. To create a segment, use the following procedure:

- Click on the Create Segment tool. The dialog box shown in Fig. 2.14-1 will open if you click on the Item’s Properties button.
- Edit the input fields as required (each input field is described below). These values will be used in the future, until they are changed again.
- Draw the segment. Click the mouse at each point required.
- After the last point has been selected, press C to close the area.
- To edit the properties of an existing segment, open its property box and edit as described earlier.

The property box allows you to define sub-segments for your segment. Check the Define subsegments checkbox and select to provide either an equal length for each subsegment, a number of subsegments, or more detailed information about the individual length of sub-segments. If you select Detailed, a table appears on the bottom of the property box where you can enter the length of each subsegment. The available remaining and total length of the segment are calculated for you automatically in the table.
**Create Column.** This tool creates a new Column with the properties input into the corresponding dialog box (Fig. 2.14-2). To create a Column, use the following procedure:

- Click on the Create Column tool. The dialog box shown below will open.
- Edit the input fields on each tab as required. These values will be used in the future, until they are changed again.
- Click the mouse at the column location (you may do this in conjunction with snapping tools).
Create Cell. This tool creates a new cell with the properties input in the corresponding dialog. To create a new cell, do the following:

- Click on the Create Cell tool. The segment’s property box opens as shown in Figure 2.14-3 (if this is the option you have selected in the General Settings tool).
- Edit the input fields on each tab as required. These values will be used in the future, until they are changed again.
- Click the mouse at one endpoint of the segment and then click at the other end.
**Create Tendon.** Creates a single tendon in the structure. Each tendon consists of one or more spans. A tendon span is a length of tendon that has a pre-defined geometry (shape). A tendon span can be a simple parabola, a reversed parabola, or other shapes. New tendons are generated by clicking on the Create Tendon tool in the Create Tendon toolbar. Click at the two ends of each tendon span as you move the cursor along the path of the tendon you intend to create. This will be treated as a continuous, multi-span tendon until you hit the “C” on the keyboard.

Each tendon span will be displayed on a straight line between the two ends identified by the mouse clicks. However, in the vertical plane, the tendon will have the shape you specify in its property dialog box.

![FIGURE 2.14-4 TENDON PROPERTY BOX](image.png)

**Create Stay.** This tool creates a stay with the properties input in the corresponding dialog. To create a stay, do the following:

- Click on the Create Stay tool. The stay’s property box opens as shown in **Figure 2.14-5** (if this is the option you have selected in the General Settings tool).
- Edit the input fields on each tab as required. These values will be used in the future, until they are changed again.
- Click the mouse at one endpoint of the stay and then click at the other end.
Create Traveler. This tool is used to create a traveler. To create a traveler click on the Create Traveler tool and follow the instructions at the bottom of the screen. To modify properties of existing traveler, open its property box as shown in Figure 2.14-6.

Create Point Support. This tool is used to specify a point anywhere on your structural model where you want to set the displacements (translation or rotation) in or about any of the three axes to zero. Positive or negative non-zero applied displacements (translation in X or Z and rotation about Y) can be assigned using the “Displacement” tab in the Point Support property box. Multiple displacements can be assigned at any scheduled Day or Step and can be set to any pre-defined load case. To insert a point support, do the following:
• Click on the Add Point Support tool, 

• Insert the point support by snapping it to the location/structural component. For example, for a column snap to the column’s center.

• To edit the properties of an existing support, open its property box as shown below.

![Figure 2.14-7 Point Support Property Box](image)

**Add Point Spring.** This tool is used to specify the point spring at any location on a structure. The insertion and view/editing is similar to a point support. The property box is shown below.
Create Restraint. This tool is used to specify restraint between two nodes of the structure. To create a restraint, click on the Create A Restraint tool and follow the instructions at the bottom of the screen. To edit restraint properties, open its property box as shown in Figure 2.14-9.
**Create Node Hinge.** This tool is used to specify a node hinge on the structure. To create a node hinge, click on the tool and follow the instructions at the bottom of the screen. To edit a node hinge, open its property box as shown in Figure 2.14-10.
Define Sections. This tool opens the Section manager dialog box (Fig. 2.14-11). Here you can define one or more sections and include them in the list of available sections. For example, to create T-section follow these steps:

- Click on the Define section tool.
- From the drop down list select section type T-section.
- Enter section dimensions.
- Click Add. The section will be added to the list of available sections.
- If you want to save this section in the library file (.lib) and load it in other models, click the Save to Library button.
- If you want to load a section that you previously saved in a library file (.lib), click on Load Library button.
The application of this toolbar is to modify the fixity of already created supports.

- **Fully Fixed.** Changes already created support to fully fixed. To modify point support, do the following:
  - Select the point support that you want to modify
  - Click on the Fully Fixed tool. The support changes to fully fixed.

- **Roller in X-direction.** Changes already created support to roller in X-direction.
Pin Support. Changes already created support to pin support.

**Roller Support in Z-direction.** Changes already created support to roller support in Z direction.

**Fixed in Rotation and Z-translation.** Changes already created support to be fixed in rotation and z translation.

**Fixed in Rotation and X-translation.** Changes already created support to be fixed in rotation and x translation.

Rotationally Fixed. Changes already created support to be rotationally fixed.

No Restraints. Changes already created support to no restraints.

Display All. Displays all point supports.

2.16 BUILD/ASSEMBLE STRUCTURE TOOLBAR

This toolbar enables you to install structural components at selected construction steps and view/edit construction sequence.

Add Cell to Structure. This tool installs cell(s) at the specified construction step. To add cell(s) using this tool do the following:

- Select step.
- Select cell(s).
- Slick Add cell to structure, tool.

Note: If you do not select a cell and click on button, the program will install all cells.
Add Tendons to Structure. This tool installs tendon(s) at the specified construction step. To add tendon(s) follow the steps as described for Add segment to structure.

Add Stay to Structure. This tool installs stay(s) at the specified construction step. To add stay(s) follow the steps as described for Add segment to structure.

Add Travelers to Structure. This tool installs traveler(s) at the specified construction step. To add traveler(s) follow the steps as described for Add segment to structure.

Add Point Support to Structure. This tool installs point support(s) at the specified construction step. To add point support(s) follow the steps as described for Add segment to structure.

Add Finite Springs to Structure. This tool installs spring(s) at the specified construction step. To add spring(s) follow the steps as described for Add segment to structure.

Add Segment to Structure. This tool installs segment(s) at the specified construction step. To add segment(s) follow the steps as described for Add cell to structure.

Add Pier/Column to Structure. This tool installs selected column(s) at the specified construction step. To add column(s) follow the steps as described for Add segment to structure.

Add Restraints to Structure. This tool installs restraint(s) at the specified construction step. To add restraint(s) follow the steps as described for Add segment to structure.

Select Events to be Performed. This tool enables you to view and edit construction sequence. Click on the button to open the Event Manager dialog window (Fig. 2.16-1). Here you can change construction sequence and specify to which construction stage you would like to output the results.
2.17 TRAVELER TOOLBAR

This toolbar groups all tools related to traveler.

- **Create Traveler.** This tool is used to create a traveler. For more detail how to create traveler refer to the Model Toolbar section.

- **Add Traveler to Structure.** This tool installs selected traveler(s) at the specified construction step. For more details on how to add traveler to structure refer to the Build/Assemble Structure Toolbar section.

- **Display/Hide Traveler.** This tool displays/hides traveler.

2.18 OFFSET AND RESTRAINT TOOLBAR
Chapter 2 TOOLBARS AND DIALOG WINDOWS

This toolbar groups all tools related to restraints.

Crete Restraint. This tool is used to create restraint. For more detail how to create restraint refer to Model Toolbar section.

Display/Hide Restraints. This tool displays/hides restraint.

2.19 LOAD REPORT TOOLBAR

This toolbar is used to display/hide loads. The tools on the toolbar are self-explanatory. The rollover hint text associated with each tool provides additional information.

Display Loads of Current Stage.

Display All Loads.

2.20 LOAD TOOLBAR

Create Point Load. This tool inserts a new point load or moment with the properties shown in Fig. 2.20-1. To create a point load, do the following.

• Click on the Create Point Load tool.
• Insert the point load.
• Open the property box of the point load (if it did not open prior to its insertion) and edit the input fields on each tab as required.
Each point load can be specified with the following load components:

Forces: Fx, Fz
Moments: Myy

Create Line Load. This tool creates a new line load with the properties shown in Fig. 2.20-2. Line loads can consist of a constant or variable force along the length of the line with or without constant or variable moment Myy along the same line. The moments are specified about the global axis.

To create a line load, do the following:

- Click on the Create Line Load tool.
- To draw the line load just click at the two endpoints of the load.
- Edit the input fields on each tab as required.
Add Self-weight. This tool enables you to add selfweight at any construction step. To add selfweight at specified step do the following:

- Select Step in Project Browser.
- Click on Add self-weight tool. The dialog window shown in Figure 2.20-3 opens.
- Specify selfweight multiplier (default is Gz = -1.00 for vertical loads acting downwards)
- Click OK.
**Temperature Load.** This tool applies temperature loads for selected segments. To specify temperature load, do the following:

- Click on the tool.
- Draw a line that identifies the location where you want to apply temperature change.
- To edit temperature load, open its property box (Fig. 2.20-4).

![Temperature Load Property Box](image)

**FIGURE 2.20-4 TEMPERATURE LOAD PROPERTY BOX**

### 2.21 REFERENCE LINE TOOLBAR

This toolbar groups all tools related to reference line.

**Transform Lines into Reference Line.** This button is used to transform a line into a reference line. For more details on how to transform lines into reference lines refer to the Transform to Structural Components Toolbar section.

**Create Reference Line.** This tool enables you to create (draw) reference lines. It is also available in Model toolbar.
2.22 SPAN/COLUMN TOOLBAR

Display/Hide Reference Line. This tool displays/hides reference lines on the screen.

Create/Identify Segment. This tool creates a new segment. For more details on how to create a segment refer to the Model Toolbar section.

Create/Identify Column or Pier. This tool creates a new column. For more details on how to create a column refer to the Model Toolbar section.

Display/Hide Segments. This tool displays/hides segment(s) on the screen.

Display/Hide Columns or Piers. This tool displays/hides column(s) on the screen.

2.23 SPRING TOOLBAR

This toolbar groups all tools related to springs.

Create Finite Spring. This tool is used to specify a spring at any location on a structure. For more details refer to the Model Toolbar section.

Add Finite Spring to Structure. This tool installs selected springs(s) at the specified construction step. For more details refer to Build/Assemble Structure Toolbar section.

Display/Hide Spring. This tool displays/hides spring(s) on the screen.
### 2.26 CELL TOOLBAR

![Cell Toolbar Image]

- **Create Cell.** This tool creates a new cell. For more details refer to Model toolbar section.

- **Transform Polygons into Cells.** This button is used to transform a polygon (closed polyline) into a cell. For more details refer to the Transform to Structural Components Toolbar section.

- **Display Cells.** This tool displays/hides cell(s) on the screen.

### 2.27 TENDON/STAY TOOLBAR

![Tendon/Stay Toolbar Image]

- **Create Tendon.** Creates a single tendon in the structure. For more details refer to Model toolbar section.

- **Transform Entity into Tendon.** This button is used to transform a line into a tendon. For more details refer to Transform to Structural Components Toolbar section.

- **Add Tendons to Structure.** This tool installs selected tendon(s) at the specified construction step. For more details refer to Build/Assemble Structure Toolbar section.

- **Display/Hide Tendons.** This tool displays/hides tendon(s) on the screen.

- **Create Stay.** Creates a single stay in the structure.

- **Add Stays to Structure.** This tool installs selected stay(s) at the specified construction step.
Chapter 2  TOOLBARS AND DIALOG WINDOWS

Transform Lines into Stay. This button is used to transform a line into a stay. For more details refer to Transform to Structural Components Toolbar section.

Display/Hide Stays. This tool displays/hides stay(s) on the screen.

2.28 MODIFY SELECTION TOOLBAR

Modify Item Properties. This tool opens the Modify Item Properties dialog box in which you can change the properties of a group of similar items, such as columns, at one time. To modify a set of items at one time, such as size of a number of columns, do the following:

- Select the items to modify.
- Click on the Modify Item Properties tool.
- Navigate through the dialog window that opens and make the modifications you want.
- Click OK to accept your modifications and exit.

Display All. This tool displays all the items that were visible on the screen prior to having used the Display Selection tool.

Display Selection. This tool displays on the screen only the items that you have selected.

Hide Selection. This tool hides the items you selected and displays the remainder of the items.

2.29 STRUCTURAL COMPONENTS/AIDS DISPLAY TOOLBAR
This toolbar is used to display/hide different components. The tools on the toolbar are self-explanatory. The hint text associated with each tool provides additional information. The following describes several of the less commonly used tools.

**View Model.** This button opens the ADAPT Solid Modeling 3D Viewer, where a three-dimensional, color view of the model is displayed. The view also may be captured as a bitmap and exported to other documents.

**Display/Hide Reference Lines.**

**Display/Hide Segments.**

**Display/Hide Columns or Piers.**

**Display Cells.**

**Display/Hide Tendons.**

**Display/Hide Stays.**

**Display/Hide Traveler.**

**Display/Hide Point Supports.**

**Display/Hide Spring.**

**Display/Hide Nodes.**

**Display/Hide Restraints.**

**Show/Hide Unconstructed Structure.**
3.1. ADAPT-ABI VIEWER MAIN SCREEN ................................................................. 77

3.2. ADAPT-ABI VIEWER MENU ITEMS ............................................................ 78
   3.2.1 File Menu ............................................................................................... 78
   3.2.2 Edit Menu ............................................................................................... 79
   3.2.3 View Menu .............................................................................................. 80
   3.2.3 User Interface Menu ................................................................................ 80
   3.2.4 Settings Menu .......................................................................................... 81
   3.2.5 Results Menu .......................................................................................... 81
   3.2.6 Tools Menu .............................................................................................. 83
   3.2.7 Moving Load Menu ................................................................................ 84

3.3. ADAPT-ABI VIEWER TOOLBARS ................................................................. 85
   3.3.1 Display Stages Toolbar ........................................................................... 85
   3.3.2 Action and Stresses Toolbar ................................................................... 85
   3.3.3 Displacement Toolbar ............................................................................ 86
   3.3.4 Settings for Results Toolbar ................................................................... 86
   3.3.5 Display Combinations ........................................................................... 87
   3.3.6 Selection Toolbar .................................................................................... 88
   3.3.7 Main Toolbar ........................................................................................... 88
   3.3.8 Scale Toolbar .......................................................................................... 89
   3.3.9 Views Toolbar ........................................................................................ 89
   3.3.10 Display Components/Entities Toolbar .................................................... 91
   3.3.11 Moving Load Toolbar ............................................................................ 94
Once the analysis is completed and saved, you can view and examine the results graphically. In this chapter we focus on graphical viewing features, and the queries that can be made from the graphical display to validate the solution.

3.1. ADAPT-ABI VIEWER MAIN SCREEN

Figure 3.1-1 shows the ADAPT-ABI Viewer screen.

**FIGURE 3.1-1 ABI VIEWER SCREEN**

**Menu Bar.** Lists all available menus. Menu options will be grayed out when they are not applicable.

**Toolbars.** Contain all available tools. The tools will not be available when they are not applicable.
**Status Bar.** Gives you information about displayed structure and results such as construction stage, day and type of action.

### 3.2 ADAPT-ABI VIEWER MENU ITEMS

All options that can be accessed through Viewer menu items are listed below. For commands that might be activated using the toolbar, the appropriate icon is displayed next to the feature.

#### 3.2.1 File Menu

The File menu operations are:

**Save.** Saves display settings under user specified filename (.adv file). The corresponding tool is located in the Main toolbar.

**Print.** Prints the content of the display screen with frame containing project information ([Fig.3.2-1](#)). Project information can be entered using Page Setup menu item ([Fig. 3.2-2](#)). The corresponding tool is located in the Main toolbar.

**Print Preview.** Gives a preview of the page as it will appear after printing.
**Page Setup.** Allows you to enter project information, and set margins and fonts as you want them to appear in the page frame. Once clicked, the Page Setup dialog box will open as shown in Figure 3.2-2. Enter project information, set the margins and font and click OK.

**FIGURE 3.2-2 PAGE SETUP DIALOG WINDOW**

**Print Setup.** Selects the paper size and orientation.

**Recently Open Files.** The program lists up to four of your most recently open files for easy access.

**Exit.** Exits the program.

### 3.2.2 Edit Menu

The Edit menu operation is:

**Copy.** This tool allows you to copy the selection. The corresponding tool is located in the Main toolbar.
3.2.3 View Menu

The View menu operations are:

**Type Display.** Enables you to display your model in different forms such as: solid, transparent, wire frame and line. It has the same function as corresponding tools in Views toolbar.

**Zoom.** Enables you to zoom in and out and pan. Has the same function as appropriate tools in the View toolbar.

**Ghost.** This menu item displays all components of the structure regardless of whether they are installed or not. The menu item has the same function as corresponding tool in the Display Components/Entities toolbar.

**Show Labels.** This menu item shows labels of all displayed entities. This option is also available through the tool in the Display Components/Entities toolbar.

**Reduce Time.** This feature moves time backward. It has the same function as the corresponding tool in the Display Stages toolbar.

**Increase Time.** Moves time forward. This feature has the same function as the corresponding tool in the Display Stages toolbar.

**Display Components/Entities.** This menu item opens a submenu that enables you to display/hide entities on the screen. The submenu items have the same function as corresponding tools in Display Components/Entities toolbar.

**Display By Selection.** This menu item opens a submenu that allows you to control visibility of entities by selection. The submenu items have the same function as corresponding tools in Selection toolbar.

3.2.3 User Interface Menu

This menu enables you to display/hide toolbars on the screen by clicking on them.
3.2.4 Settings Menu

This menu allows you to set the display properties of all entities as well as the display properties of graphical solution plots. The menu items have the same functions as corresponding tools in the Display Components/Entities toolbar.

3.2.5 Results Menu

The Results menu items are as follows:

**Results Type.** This menu item controls display of results. The submenu items have the same function as corresponding tools in the Settings For Results toolbar and are as follows:

- **Solid Plot/Line Plot.** This menu is a toggle switch for viewing the plots in filled color or lines.
- **Line Contour.** Shows the stress variation by line contour.
- **Color Contour.** Shows the stress distribution in distinct color contour.
- **Values.** Shows the numerical values of selected results.
- **Display Min/Max Values.** Shows the minimum and maximum values of the selected results.

**Redraw Results.** This menu item clears and then re-draws the results display. It has the same function as the corresponding tool in the Action and Stresses toolbar.

**Bending Moment.** Displays bending moment. It has the same function as the corresponding tool in the Action and Stresses toolbar.

**Shear.** Shows force normal to the frame direction. It has the same function as the corresponding tool in the Action and Stresses toolbar.

**Axial.** Shows force in direction of frame. It has the same function as the corresponding tool in the Action and Stresses toolbar.
**Prestressing.** Displays total prestressing force. It has the same function as the corresponding tool in the Action and Stresses toolbar.

**Stress Contour.** Displays distribution of stress in frame element. It has the same function as the corresponding tool in the Action and Stresses toolbar.

**Torsion Moment.** Displays torsion moment. It has the same function as the corresponding tool in the Action and Stresses toolbar.

**Deflection.** Shows displacement from the installation point. It has the same function as the corresponding tool in the Displacement toolbar.

**Camber.** Shows correction for displacement from installation point. It has the same function as the corresponding tool in the Displacement toolbar.

**Vertical Deflection.** Shows vertical displacement from installation point. It has the same function as the corresponding tool in the Displacement toolbar.

**Horizontal Deflection.** Shows horizontal displacement from installation point. It has the same function as the corresponding tool in the Displacement toolbar.

**Vectorial Deflection.** Shows combined vertical and horizontal displacement from installation point. It has the same function as the corresponding tool in the Displacement toolbar.

**Display Values.** Shows the numerical values of selected results. It has the same function as the corresponding tool in the Settings for Results toolbar.

**Load Case/Envelope/Combination.** This menu item enables you to select load case, combination or envelope for which you want to display results and also gives you an option to display maximum or minimum values of an envelope. The submenus have the same functions as corresponding tools in the Display Combination toolbar.

- **Previous.** Displays the previous load case/combination/envelope.
3.2.6 Tools Menu

This menu provides you with the option of increasing or reducing the dimension of the model in Y direction, or the ordinates of the graphs of actions. The menu items have the same functions as corresponding tools in the Scale toolbar.

**Scale Y Minus.** Reduces the Y-scale of the structural model. The corresponding tool is located in the Scale toolbar.

**Scale Y To 1.** Displays structural model with true scale. The corresponding tool is located in the Scale toolbar.

**Scale Y Plus.** Increases the Y-scale of the structural model. The corresponding tool is located in the Scale toolbar.

**Decrease the Values.** Reduces the ordinates of the graph of actions. The corresponding tool is located in the Scale toolbar.

**Normalize the Values.** Shows the graphs of actions with the scale of the program default. The corresponding tool is located in the Scale toolbar.

**Increase the Values.** Increases the ordinates of the graph of actions. The corresponding tool is located in the Scale toolbar.

**Selection.** This menu enables you to select entities. Its submenus have the same functions as corresponding tools in the Selection toolbar.

- **Click to Select.** Select entities by clicking on them.
- **Select All.** Selects all the entities displayed on the screen.
- **Deselect All.** Deselects all the displayed entities.
Chapter 3  
ABI VIEWER MENU ITEMS AND TOOLBARS

- **Mirror Selection.** Select all entities that were not selected while deselecting the current selection.

- **Edit Selection List.** This submenu item opens a dialog box as shown in Figure 3.2-3. Here you can select items by type, group, Materials and Load Cases.

![Selection Lists Dialog Window](image)

**FIGURE 3.2-3 SELECTION LISTS DIALOG WINDOW**

- **Select Structural Entity.** Selects all entities that were not clicked on.

3.2.7 Moving Load Menu

The Moving Load menu operation is:

**Influence Line.** Allows you to select the frame/node for which you would like to see influence lines. It has the same function as the corresponding tool in the Moving Load toolbar.
3.3 ADAPT-ABI VIEWER TOOLBARS

3.3.1 Display Stages Toolbar

This toolbar enables you to select the stage in the construction phase for which you would like to display results.

↓ **Reduce Time.** Moves time backward.

↑ **Increase Time.** Moves time forward.

← **Construction Phase.** Enables you to display times dependent on construction stages and actions.

<table>
<thead>
<tr>
<th>Day 45</th>
<th>Stage 1</th>
</tr>
</thead>
</table>

Lists all time-dependent construction stages for which the results are available.

3.3.2 Action and Stresses Toolbar

This toolbar is used to display different actions and stresses.

锪 **Redraw Results.** This button clears and then re-draws the results display.

 **Bending Moment.** Displays bending moment.

.heap **Shear.** Shows force normal to the frame direction.

힐 **Axial.** Shows force in direction of frame.
- **Prestressing.** Displays total prestressing force.

- **Stress Contour.** Displays distribution of stress in frame element.

- **Torsion Moment.** Displays torsion moment.

### 3.3.3 Displacement Toolbar

![Displacements](image)

This toolbar is used to display deformation of the structure.

- **Display actual structure.** Shows actual structure.

- **Deflection.** Shows displacement from the installation point.

- **Camber.** Shows correction for displacement from installation point.

- **Horizontal Deflection.** Shows horizontal displacement from installation point.

- **Vertical Deflection.** Shows vertical displacement from installation point.

- **Vectoral Deflection.** Shows combined vertical and horizontal displacement from installation point.

### 3.3.4 Settings for Results Toolbar

![Settings For Results](image)

This toolbar controls display of results.
Solid Plot/Line Plot. This tool provides a toggle switch for viewing the plots in filled color or lines.

Line Contour. Shows the stress variation by line contour.

Color Contour. Shows the stress distribution in distinct color contour.

Values. Shows the numerical values of selected results.

Display Min/Max Values. Shows the minimum and maximum values of the selected results.

3.3.5 Display Combinations

This toolbar enables you to select load cases, combinations and envelopes for which you would like to display results.

Post-Construction. Enables you to display post construction load cases, combinations and envelopes.

Previous. Displays the previous load case/combination/envelope.

Next. Displays the next load case/combination/envelope.

Display Maxima. Displays the envelope of maximum values only.

Display Minima. Displays the envelope of minimum values only.

List of all available load cases, combinations and envelopes.
3.3.6 Selection Toolbar

- **Manual Selection.** Selects entities by clicking on them.
- **Select All.** Selects all the entities displayed on the screen.
- **Select None.** Deselects all the displayed entities.
- **Inverse Selection.** Selects all entities that were not selected while deselecting the current selection.
- **Select Structural Entity.** Selects all entities that were not clicked on. Click on this tool, select Ctrl key and click on the element that you do not want to select. The program will select all other elements.
- **Select Composite Elements.** Enables you to display results of a composite section.
- **Display All.** Displays all entities.
- **Hide Selection.** Hides all selected entities.

3.3.7 Main Toolbar

- **Save (CTRL+S).** Saves display settings under user-specified filename (.adv file).
- **Copy (CTRL+C).** This tool allows you to copy the selection.
Print (CTRL+P). Prints the screen content with frame containing project information.

3.3.8 Scale Toolbar

This toolbar allows you to increase or reduce the dimension of the model in Y direction, or the ordinates of the graphs of actions.

- Decrease Y-scale. Reduces the Y-scale of the structural model.
- Display to Scale. Displays structural model with true scale.
- Increase Y-scale. Increases the Y-scale of the structural model.
- Scale Down Values. Reduces the ordinates of the graph of actions.
- Values with Default Scale. Shows the graphs of actions with the scale of the program default.
- Scale Up Values. Increases the ordinates of the graph of actions.

3.3.9 Views Toolbar

This toolbar is used to display different views of the model, zoom in or out, pan and show multiple port views of the structure. The tools on the toolbar are self-explanatory.

- Generate a Bitmap. Click on this tool to capture the 3D viewer image in bitmap format. You can ask the program to save this image for use in project reports or other purposes. Once clicked, the dialog window shown in Fig. 3.3-1 opens. Note that apart from
choosing your own title and location for saving the file, you can specify a title and subtitle for the image and its position in the report page.

![Generate Bitmap dialog box](image)

**FIGURE 3.3-1 DIALOG BOX FOR SCREEN CAPTURE**

The following buttons display the model from different angles.

- Front View.
- Back View.
- Right View.
- Left View.
- Top View.
- Bottom View.
- Perspective 1 View.
- Perspective 2 View.
- Perspective 3 View.
- Zoom Window.
- Zoom Extents.
Zoom In.

Zoom Out.

Dynamic Pan.

Rotate.

Display the model in solid form.

Display the model in transparent (see through) mode.

Display the model in wire frame.

Display the frames as lines (represented by their center lines).

Display the model in gray scale (black and white).

3.3.10 Display Components/Entities Toolbar

Entity Display Settings. This tool controls the graphics of all entities. Once clicked, the dialog window shown in Fig. 3.3-2 opens. Make modifications and click OK button to update the display of entities.
Results Display Settings. This tool controls the graphics of all solutions. Once clicked, the dialog window shown in Fig. 3.3-3 opens. Make modifications and click OK button to update the display of entities.

FIGURE 3.3-2 SETTINGS FOR STRUCTURE ENTITIES DIALOG WINDOW

FIGURE 3.3-3 DRAWING CONTROL DIALOG WINDOW
**Show Labels.** This tool shows labels of all displayed entities.

**Ghost.** This tool displays all components of the structure regardless of whether they are installed or not.

**Display Nodes.** This tool displays nodes of the structure. Use the Entity Display Settings dialog box to set the display properties.

**Display Frame Elements.** This tool displays frame elements of the structure. Use the Entity Display Settings dialog box to set the display properties.

**Display Tendons.** This tool displays tendons. Use the Entity Display Settings dialog box to set the display properties.

**Display Stays.** This tool displays stays. Use the Entity Display Settings dialog box to set the display properties.

**Display Springs.** This tool displays springs. Use the Entity Display Settings dialog box to set the display properties.

**Display Restraint/Releases.** This tool displays restraints/releases. Use the Entity Display Settings dialog box to set the display properties.

**Display Offset.** This tool displays offset. Use the Entity Display Settings dialog box to set the display properties.

**Display Master and Slaves.** This tool displays master/slave connections. Use the Entity Display Settings dialog box to set the display properties.

**Display Travelers.** This tool displays travelers. Use the Entity Display Settings dialog box to set the display properties.

**Display Point Load.** This tool displays point loads. Use the Entity Display Settings dialog box to set the display properties.
**Display distributed Loads.** This tool displays uniform distributed applied loads. Use the Entity Display Settings dialog box to set the display properties.

**Display Total/This Stage Loads.** This tool displays all loads. Use the Entity Display Settings dialog box to set the display properties.

**Display Applied Displacements.** This tool displays applied displacements at the nodes.

**All Structural Components.** This tool displays all structural components.

**Display No structural Components.** This tool hides all structural components. Only the solution is displayed.

**Display by Components.** This tool drops the list of components/entities and lets you select the ones to be displayed.

**Display Selected Group.** This tool drops a list of groups previously created by you and lets you select groups to be displayed.

### 3.3.11 Moving Load Toolbar

This toolbar enables you to display load paths that you previously defined. Also, it allows you to see influence lines for different nodes of the structure.

**Travel Path TRAVEL_PATH_1** Drop down list of all travel paths that you previously defined.

**Display Influence Lines.** Allow you to select the frame/node for which you would like to see influence lines. Once clicked, the Influence Line Input dialog box opens (Fig. 3.3-4). From the drop-
down list, select the frame element (for example frame element 4). Below the list the program shows corresponding nodes (nodes 6 and 7 are nodes of element 4). Select one of them. To show influence line click on the appropriate tool in the Actions and Stresses toolbar. For example, if you would like to see an influence line for moments click on the Bending Moment tool.

![FIGURE 3.3-4 INFLUENCE LINE INPUT DIALOG WINDOW](image)

**Influence Line Node.** This tool enables you to select node for display of influence lines similar as Display Influence Lines tool.